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Introduction to Invoices

The Invoices program allows you to generate invoices for customer remittance, issue statements of
receivables, and create checks for your customers. Invoicing is based on account collection activity in
Latitude.

Ensure that your organization set the following Accounting permissions for each user of Invoices:
e Access Invoices Program: Allows users to open Invoices.

o Enter AR Payments: Allows users to add accounts receivable payment information to apply
toward invoices.

e Enter Bank Transactions: Allows users to add bank transactions for trust accounts.
e Generate Invoices: Allows users to generate invoices.
e Generate Statements: Allows users to generate statements.
e  Print Checks: Allows users to print and reprint checks.
What's New in Invoices

The following Service Updates (SU) introduced changes and enhancements to Invoices 10.0:
SU5

Invoicing options

Added Apply to Oldest First check box in the Options dialog box for applying payments to the oldest
accounts receivable balance first. For more information, see Specify Default Invoicing Options.

SU9

Added ability to preview, export, and print invoices.

Log On to Invoices
Use the Latitude Logon dialog box to log on to Invoices.
To log on to Invoices

1. Click Start > All Programs > Latitude Software > Invoices or double-click the Invoices icon. The
Latitude Logon dialog box appears.

& |Latitude Login

User Name; ||

Password: |

Database: |Defnult Instance

r Log in using Windows aubhenbcabon

Cancel

2. Inthe User Name box, type your Latitude user name.
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3. Inthe Password box, type your Latitude password. As you type your password, periods display
instead of the typed characters.

4. Click Okay. The Invoices window appears.

Note: If your agency has over 1,000 customers, a dialog box appears, prompting you to bypass
loading of all customers. To prevent slow response times when opening the Invoices window,
click No. A second dialog box appears, indicating the operation may take several moments to
return results. Click No again.

(S )

Summany of lraoices | Summary of Open ltems |

i b D0000DD-DEF&AILT

-Gl 0000001-CUSTOM All Customers
0000002-CUSTOM

i 3 0000003-POD CUS

i 0000004-CUSTOM View Date Range

r .
%ggggﬁﬁ [6/3/m2 =] w4020z -l
DI00007-FIRST CL
D00000E-SECOMD
D00000S-THIRD CL
o000 0-DISMEY € Consobdated Summary of Invoices for All Customens
O000011-48C Cust Irnedice Giross Collections Fees

lvoice | Date [SpsMo| Padlz | PadCust | TotalPmis | Eamed

Cugtamst Gioup Selected "l Customens” 851 &AM A0/2003

Overview of Invoices Window

Use the Invoices window to generate invoices, issue receivables statements, and create checks for your
customers.
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= =
Actions  Tools View Reports

SLITI'ﬂaI_I.!d IPnedices | Summary of Open ltems | 3

- b D0000DD-DEF&LLT
-l D000001-CUSTOM All Customers
0000002-CLIS T OM
0000003-POD CUS
m 0000004-CLUSTOM View Date Rangs
OO0000S-DIALER T
DO0000E-CLUS T OM l6/3s2m2 =] w|4n02m3 -]
D000007-FIRST CL
D00000e-5SECOMND

0000003 THIRD CL
00001 0-DISMEY € Consobdated Summary of Irvoices for All Customers

0000011-8EC Cush Irnoice Gregs Collections Fees Summary
lnvoice | Date |SpsMo| PadUs | PadCust | TotalPmiz | Eamed DusUs | Due Cust

Cugtomer Group Selected "Wl Cusbomes" B &M 41042013

1. Menu: Displays the commands that are available for the window.

2. Navigation pane: Displays the available customers. The icons indicate if the customer is the
parent customer, child customer, or a standard customer.

Icon | Description

Parent customer. You can use parent customers to combine invoices for multiple
5] customers under one invoice. For example, your agency may hold accounts for a major
company (parent customer) that has several subsidiaries (child customers).

o Child customer. You can assign child customers to a parent customer for invoicing
purposes. You cannot invoice a child customer separately.

ﬂ Standard customer. Customers that your organization hasn't associated to other
customers.

3. Tabs: When you click a customer in the Navigation pane, the associated information appears on
the selected tab.
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Help Overview

Invoices help provides you with information for using Invoices. Use the table of contents, index, and
search features to locate and view a topic.

To open help

In the "\Latitude Software\Documents" folder, double-click Invoices.chm.

% Help System - O *

& &

I'MEMFom‘thﬁ‘l1

Contents |w |E-aa'|:,h| 2 31 Home | Help System

e SGENESYS 4 festms
Logon

Book 1 Introduction 5
Bosk 2

Bosk 3 This graphic represents the help system layout
for Latitude by Genesys products.

Lorem ipsum delor sit amet, vix id quot
aperiam sententiae, no mea definiebas
referrentur voluptatibus. Soluta meliore eu
mei, pro alienum legendos definitionem in,
sumo essent legendos ea vix. At vim veritus
senserit adversarium, has in dignissim
conceptam, ei sit veritus accumsan. Te odio
urbanitas pri, tamguam honestatis vel ex, at
quo enim virtute.

Mei impetus saperet ea, no saperet
disputationi his. Nam diam quas appellantur
tu. Duo nonumy vituperata in. Nec ex saperet
civibus denique, quo dolorem consetetur eu.

Tip: To adjust the width and height of the window or its panes, click the edge of the window or pane
and drag it up or down, left or right.

1. Toolbar: Displays options for the help window.
2. Tabs: Displays the following:

Contents: Displays the table of contents. To display a topic in the Content pane, expand a book
and then click the link.

Index: Displays the index. To display a topic in the Content pane, type a keyword or phrase in the
box (or scroll through the list) and then click the link in the list.

Search: Displays the search feature. To display a topic in the Content pane, type a keyword or
phrase in the box and then press Enter. In the search results, click the link.

Glossary: Displays a list of terms and their definitions. To display a definition, click the term.

3. Breadcrumbs: Displays your current location within the help system. When you click a
breadcrumb, the related topic displays.
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4. Content toolbar: Displays an option to send feedback through an email message to Latitude by
Genesys Documentation.

5. Content pane: Displays the contents of a topic. To view the Content pane menu, right-click in
the Content pane.

Search feature

You can use the search feature to search for topics that contain words or phrases that you specify. You
formulate a search query following a specific set of rules. You can include wildcard expressions, Boolean
operators, and nested expressions in your search query. A list of topics that match your search criteria
appear in the search results. When you click a topic title in the search results, the content of that topic
appears in the Content pane.

Search syntax
The basic rules for formulating search queries are:
e Searches are not case-sensitive, meaning you can type uppercase or lowercase characters.

e You cannot search for a single character or the following reserved words: an, and, as, at, be, but,
by, do, for, from, have, he, in, it, not, of, on, or, she, that, the, there, they, this, to, we, which,
with, you.

e The search engine ignores punctuation marks and special characters such as @#5$%"&()=+[]\.

e Enclose phrases and terms that include a period (such as a file name with an extension) in
double quotation marks.

Wildcard expressions

Wildcard expressions allow you to search for one or more characters using a question mark or asterisk.
A question mark represents a single character, while an asterisk represents one or more characters.

Search for... Example [Result

Topics with text that starts with one or
more specified characters and ends in [og or log*
any character or number of characters

Returns all topics with text that starts with the
specified characters (for example, log, logon, logging.)

Topics with text that starts with the
specified characters, has a single
character that can be anything, and
ends in the specified characters

Returns all topics with text that has any character
32757 where you placed a question mark (for example,
32?57 returns 32257, 32457, and 32857.)

Returns all topics with both account and status, but
account |not necessarily as a phrase or in the order specified.
status For example, the search returns topics with "the
account status..." or "the status of the account..."

Topics that contain all the words
specified, in any order or placement
within the topic

Returns all topics with account status as a phrase. For
example, the search returns topics with "the account
status..." but not "the status of the account..."

Topics that contain the specified "account
phrase status"
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Boolean operators

Boolean operators (AND, OR, NOT, NEAR) allow you to create a relationship between terms. If you don't
specify an operator, the system uses AND by default.

Search

cor... Example Result

Returns all topics with both account and status, but not necessarily as a phrase or
account AND|, o : -
AND ctatus in the order specified. For example, the search returns topics with "the account
status..." or "the status of the account..."

account OR . . .
OR ctatus Returns all topics with either account or status, or both.

account NOT

NOT Returns all topics with account but not status.
status
dccount . .

NEAR Returns all topics where account is within eight words of status.
NEAR status

Nested expressions

Nested expressions allow you to perform complex searches. For example, queue AND ((collector OR
clerical) not supervisor) finds topics containing queue and collector but not supervisor, or containing
queue and clerical but not supervisor. As with mathematical expressions, the system evaluates
expressions in parentheses first. If there is no parenthesis, the system evaluates the expression from left
to right. For example, queue NOT (clerical OR supervisor) finds topics containing queue but not clerical
or supervisor. Queue NOT clerical OR supervisor finds topics containing queue but not clerical, or topics
containing supervisor.

Customers

Customers
Use the Invoices window to select groups of customers to view, search for customers, and modify
customer information. You can also set up customer groups and associate customers to the groups.
Select Customers to Display in the Navigation Pane
Use the Invoices window to select the customers to display in the Navigation pane.
To select customers to display in the Navigation pane

e Inthe Invoices window, from the View menu, do one of the following:

o Todisplay a list of all customers, click All Customers. The Navigation pane displays a list
of all customers.

o Todisplay a list of customers that your organization invoices monthly, click Monthly
Customers. The Navigation pane displays a list of customers that you invoice monthly.

o Todisplay a list of customers that your organization invoices weekly, click Weekly
Customers. The Navigation pane displays a list of customers that you invoice weekly.

10
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o Todisplay a list of customers that your organization invoices on demand, click On
Demand Customers. The Navigation pane displays a list of customers that you invoice
on demand.

o Todisplay a list of customers in the default customer group, click Default Group. The
Navigation pane displays a list of customers in the default customer group.

o Todisplay a list of customers in a specific customer group, click the group name. The
Navigation pane displays a list of customers in the specified customer group.
Search for a Customer
Use the Simple Search tab in the Search - Search for Customer window to search for a customer.
To search for a customer
1. From the Tools menu, click Find Customer. The Search - Search for Customer window appears.

[ seacnforcusomer LU

Simple Search Isc,m-d-. Results ] For help with wild card searching, dick here,
Customer Code: I'UGDDDHI

Customer Namc:l
Customer Group{ No items selected. il
Alpha Code: I

Contact Name: I

Maximum results: I 250 3: Search complete, 1 results retumed. Clear | | Search |

2. On the Simple Search tab, type search criteria into one or more boxes.
I Tip: For fewer results, provide more information. For more results, provide less information. I
3. Click Search. The results display on the Search Results tab.
Tmentee I
Simple Search  Search Resuits |

Customer Code | Customer Mame | Alpha Code | Company Name | Contact Name | Address | City
0000001 CUSTOMER. ONE 123 MAIN STREET | JACKSOMVILLE | FL

4| | ¥

Maximum results: I 250 5: Search complete, 1 results retumed. Back | | Selact I

4. Click Select. The customer's information displays in the Invoices window.

11
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Modify Customer Information

Use the Customer Properties window to modify customer information. For more information about this
window and its tabs, see the "Maintain a Customer" topic in the Latitude documentation.

To modify customer information

1. Inthe Invoices window, in the Navigation pane, right-click a customer and then click Properties.
The Customer Properties window appears.

( S Customer Properties: 0000001 CUSTOMER OME |
General | Account | Fees | mvoice | Services | ifo | Desk Distrioution | Comments | Custom |

Cade 0D0ooo1 Status [ACTIVE |
AlphaCode | |
Hame CUSTOMER OMNE |
Addraze [123 MAIN STREET |

[SLITE 100 |
Ciy/Stale/Zip  [VACKSONVILLE |[FL ] [z2248 |
Cantact [MATT |
Phaone [FE 122 | Fax| |
Email Address [I:-arl:-ara maitiEinin comn ]
Defauk lrteses ||:I |

Enarity 10

k] concel |

L — A

2. Modify the information as necessary and then click OK.
Customer Groups

Customer Groups

Use the Customer Groups window to add and modify customer groups. Customer Groups represent
general types of collection business given to your agency. You can use Customer Groups to categorize
customers for invoicing and statistics. You can place individual customers into one or more groups (or
none).

Add a Customer Group
Use the New Custom Group dialog box to add a customer group.
To add a customer group

1. Inthe Invoices window, from the Tools menu, click Custom Group Editor. The Customer Groups
window appears.

12
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4.

Modify a Customer Group
Use the Edit Customer Group dialog box to modify a customer group.

To modify a customer group

Invoices Printable Help

M New Custom Group
Custom Group's |D [30 Char]

Custom Group'z Descriphon 100 Cha- Ophonal)

=

B

LCancel

| Ok |

S Customer Groups E@E
g Mew Group i Refrash B seanch
- Code | Mame | Clasz
=] Banks - Banks [F]  0DIOD0E BOBS HAALEYS 00001 - RETAIL
-] 000000 - Smalkown Bank  (§¥]  gooo000 DEFAULT CUSTOMER 00003 - TEST CLASS OF BUSINESS

(- Coedit Card Customess - Lredit C2 |\ F51 oognos Famers Bank 00007 « RETAIL

- Sichooks - Schools IF] 0000004 FRANKLIN CREDIT SOLUTIONS 00003 - STUDENT LOANS
] 0000014 KEY FINANCIAL CORP 00003 - STUDENT LOANS
] 000000 Porttoio 1 00000 - GEMERAL CLASS OF BUSINES
IC] o002 Ponigio 2 00000 - GEMERAL CLASS OF BUSINES
| (s 0003 PORTFOLIO 3 00000 - GEMERAL CLASS OF BUSIMES
IE] 0000008 PORTFOLIO DELMITED 00000 - GEMERAL CLASS OF BUSIMES
IC]  DODOODS PORTFOLIO EXCEL D000 - GEMERAL CLASS OF BUSINES
IE] (000010 PORTFOLIO Fi= 00000 - GEMERAL CLASS OF BUSINES
] 0000005 Smaltown Bark 00000 - GEMERAL CLASS OF BUSINES
] o000tz SODIN E210 00000 - GEMERAL CLASS OF BUSINES
(s 0000007 SO0IN 229 00000 - GEMERAL CLASS OF BUSIMES
) ooooot1 sODIN E291 D000 - GEMERAL CLASS OF BUSINES

From the menu bar, click New Group. The New Custom Group dialog box appears.

Custom Group's ID (30 Char): Unique code that identifies the customer group. The ID can be up
to 30 characters in length.

Custom Group's Description (100 Char - Optional): Description of the customer group, up to 100

characters in length.

Complete the information and then click OK.

To assign a customer to the customer group, see Add a Customer to a Customer Group.

In the Invoices window, from the Tools menu, click Custom Group Editor. The Customer Groups

window appears.

13
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S Customer Groups E@E
g Mew Group i Refrash B seanch
- Code | Mame | Clasz
=] Banks - Banks [F]  0DIOD0E BOBS HAALEYS 00001 - RETAIL
-] 000000 - Smalkown Bank  (§¥]  gooo000 DEFAULT CUSTOMER 00003 - TEST CLASS OF BUSINESS

(- Coedit Card Customess - Lredit C2 |\ F51 oognos Famers Bank 00007 « RETAIL

- Sichooks - Schools IF] 0000004 FRANKLIN CREDIT SOLUTIONS 00003 - STUDENT LOANS
] 0000014 KEY FINANCIAL CORP 00003 - STUDENT LOANS
] 000000 Porttoio 1 00000 - GEMERAL CLASS OF BUSINES
IC] o002 Ponigio 2 00000 - GEMERAL CLASS OF BUSINES
| (s 0003 PORTFOLIO 3 00000 - GEMERAL CLASS OF BUSIMES
IE] 0000008 PORTFOLIO DELMITED 00000 - GEMERAL CLASS OF BUSIMES
IC]  DODOODS PORTFOLIO EXCEL D000 - GEMERAL CLASS OF BUSINES
IE] (000010 PORTFOLIO Fi= 00000 - GEMERAL CLASS OF BUSINES
] 0000005 Smaltown Bark 00000 - GEMERAL CLASS OF BUSINES
] o000tz SODIN E210 00000 - GEMERAL CLASS OF BUSINES
(s 0000007 SO0IN 229 00000 - GEMERAL CLASS OF BUSIMES
) ooooot1 sODIN E291 D000 - GEMERAL CLASS OF BUSINES

2. Inthe Navigation pane, right-click the customer group to modify and then click Edit. The Edit
Custom Group dialog box appears.

-

n Edit Custamn Group (Banks) E
Custom Group's 1D [30 Char]
Banks |
Custom Group's Descriptan [100 Cha- Dptional)
IEanka

s | [

Custom Group's ID (30 Char): Unique code that identifies the customer group. The ID can be up
to 30 characters in length.

Custom Group's Description (100 Char - Optional): Description of the customer group, up to 100
characters in length.

3. Modify the information as necessary and then click Save.

Delete a Customer Group
Use the Customer Groups window to delete a customer group.
To delete a customer group

1. Inthe Invoices window, from the Tools menu, click Custom Group Editor. The Customer Groups
window appears.

14
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S Customer Groups E@@
g Mew Group i Refrash B seanch
- Code | Mame | Clasz
=] Banks - Banks [F]  0DIOD0E BOBS HAALEYS 00001 - RETAIL
-] 000000 - Smalkown Bank  (§¥]  gooo000 DEFAULT CUSTOMER 00003 - TEST CLASS OF BUSINESS

(- Coedit Card Customess - Lredit C2 |\ F51 oognos Famers Bank 00007 « RETAIL

- Sichooks - Schools IF] 0000004 FRANKLIN CREDIT SOLUTIONS 00003 - STUDENT LOANS
] 0000014 KEY FINANCIAL CORP 00003 - STUDENT LOANS
] 000000 Porttoio 1 00000 - GEMERAL CLASS OF BUSINES
IC] o002 Ponigio 2 00000 - GEMERAL CLASS OF BUSINES
| (s 0003 PORTFOLIO 3 00000 - GEMERAL CLASS OF BUSIMES
IE] 0000008 PORTFOLIO DELMITED 00000 - GEMERAL CLASS OF BUSIMES
IC]  DODOODS PORTFOLIO EXCEL D000 - GEMERAL CLASS OF BUSINES
IE] (000010 PORTFOLIO Fi= 00000 - GEMERAL CLASS OF BUSINES
] 0000005 Smaltown Bark 00000 - GEMERAL CLASS OF BUSINES
] o000tz SODIN E210 00000 - GEMERAL CLASS OF BUSINES
(s 0000007 SO0IN 229 00000 - GEMERAL CLASS OF BUSIMES
) ooooot1 sODIN E291 D000 - GEMERAL CLASS OF BUSINES

2. Inthe Navigation pane, right-click the customer group and then click Delete Group. The Delete
Custom Group dialog box appears.

3. Click Yes and in the next dialog box, click OK. The Invoices program deletes the customer group.

The customers associated to the group remain in the system.

Modify Customer Group Settings

Use the Customer Groups window to modify customer group settings.

To modify customer group settings

1. Inthe Invoices window, from the Tools menu, click Custom Group Editor. The Customer Groups

window appears.

15
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2.

ﬂ Meww Groug .e Refresh

I ]

] E Banks - Barks

L) 000000 - Smslkown Bank
(-0 Credit Card Customess - Credit Cz
(-0 Schools - Schools

" Search
Code | Mame | Clasz

[F]  0D00O0E EOBS HARLEYS 00007 - RETAIL
= 0000000 DEFAULT CUSTOMER 00003 - TEST CLASS OF BUSIMNESS
Il 0000005 Famers Bank 00007 - RETAIL
[E] 0000004 FRANKLIN CREDIT SOLUTIONS 00003 - STUDENT LOAMS
] ooDOM4 KEY FINANCIAL CORP 00003 - STUDENT LOANS
] 0o000m Portioio 00000 - GEMERAL CLASS OF BUSINES
IE]  oomooz Ponfoic 2 00000 - GEMERAL CLASS OF BUSINES
] 0o0om3 PORTFOLIO 3 00000 - GEMERAL CLASS OF BUSINES
E 0000008 PORTFOLIO DELIMITED 00000 - GEMERAL CLASS OF BUSINES

OO0O00E PORTFOLIO EXCEL 00000 - GEMERAL CLASS OF BUSINES
El 0000Mmo PORTFOLIO Fi< (0000 - GEMERAL CLASS OF BUSINES
E] 0000008 Smaltown Bank 00000 - GEMERAL CLASS OF BUSINES
] 0000012 SODIN E210 00000 - GEMERAL CLASS OF BUSINES
£l  oooooo7 SODIN 829 00000 - GEMERAL CLASS OF BUSINES
] oomon sooiN &z 00000 - GEMERAL CLASS OF BUSINES

In the Navigation pane, click a customer group. The customer group settings appear in the

Information pane.

g Mew Group 2 Refresh

#h Search

[ % customerGeowes S oe]

:-gﬁ.lﬁm:
E.

#1-[C] Ciedt Card Customers - Credi Ca
&-[_1 Schook: - Schoolz

Banksz - Banks

[~ Display Group on Stalistics Consale

[™ Displat Group in Inwoece applcation

En‘l&l Mame

| Cless

000000E  Smaltaver Bank

00000 - GEMERAL CLASS OF BUSINES

Display Group on Statistics Console: If selected, the customer group is available for selection in

Statistics Console.

Display Group in Invoice application: If selected, the customer group is available for selection in

Invoices.
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3. Inthe Information pane, complete the information. The Invoices program saves your changes
instantly.
Add a Customer to a Customer Group
Use the Customer Groups window to add a customer to a customer group.
To add a customer to a customer group

1. Inthe Invoices window, from the Tools menu, click Custom Group Editor. The Customer Groups
window appears.

H Customer Groups EE
'.'_] MNew Group .e,’ Refresh “ Search
Cods | Mame Class
(= Banks - Banks IF]  O0o00D3 BOBS HAALEYS 00001 - RETAIL
I} 000D00E - Smalkown Bank. | B51 joogo0g DEFAULT CUSTOMER 00003 - TEST CLASS OF BUSINESS
5} __| Credit Card Customess - Credit Cz E 0000005 Eamers Bank 0001 - RETAIL
-2 Schools - Schools [F|  0DO0DD4 FRANKLIN CREDIT SOLUTIONS 00003 - STUDENT LOAMS
|« 0000014 EEY FINAMCIAL CORP 00003 - STUDENT LOAMS
] 0000001 Percliz 1 00000 - GEMERAL CLASS OF BUSIMES
] Do00D0Z Puticio 2 00000 - GEMERAL CLASS OF BUSINES
(s 00003 PORTFOLIO 3 00000 - GEMERAL CLASS OF BUSIMES
IE] 0000003 EORTFOLIO DELIMITED 00000 - GEMERAL CLASS OF BUSINES
I]  DO0000S PORTFOLIO EXCEL 00000 - GEMERAL CLASS OF BUSINES
I 000000 PORTFOLIO Fi= 00000 - GEMERAL CLASS OF BUSIMES
IE] 0000005 Smalbow Bark 00000 - GEMERAL CLASS OF BUSIMES
L] oooooiz SODIN 8210 00000 - GEMERAL CLASS OF BUSINES
] 0000007 SODIN 829 00000 - GEMERAL CLASS OF BUSIMES
©]  0DDOO11 SODIN 2291 00000 - GEMERAL CLASS OF BUSINES

2. Inthe Navigation pane, click All Customers. All customers in the system appear in the
Information pane.

3. Inthe Information pane, click a customer, and then drag and drop it onto a customer group in
the Navigation pane.

4. Do one of the following to select multiple customers to drag and drop onto a customer group:

e To select contiguous customers, click the first customer to select, hold down the Shift
key and click the last customer to select. Drag and drop the customers to the customer
group.

e To select non-contiguous customers, click the first customer to select, hold down the
Ctrl key and click each additional customer to select. Drag and drop the customers to
the customer group.

Modify a Customer in a Customer Group

Use the Customer Groups window to modify a customer.

17
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To modify a customer in a customer group

18

1.

2.

In the Invoices window, from the Tools menu, click Custom Group Editor. The Customer Groups

window appears.

ﬂ MNeww Grougp e Refresh

Frrrser e ]

] E Banks - Barks

L) D00000G - Smelkown Bank
B0 Credit Card Customess - Credit Cz
f#-(20 Schools - Schools

“ Search
Code | Hame | Clazz

IF]  00IOODE BOBS HAALEYS 00001 - RETAIL
] 00D0O0DD DEFAULT CUSTOMER 00003 - TEST CLASS OF BUSINESS
] 0000005 Famers Bank 00007 - RETAIL
IE] 0000004 FRANKLIN CREDIT SOLUTIONS 00003 - STUDENT LOAMS
EI 0000014 EEY FINAMCIAL CORP 00003 - STUDENT LOAMS
] 0000000 Portfolio 1 00000 - GEMERAL CLASS OF BUSIMES
IE]  oomooz Poicic 2 00000 - GEMERAL CLASS OF BUSIMES
] oooom3 PORTFOLIO 3 00000 - GEMERAL CLASS OF BUSINES
El 0000002 PORTFOLIO DELIMITED 00000 - GEMERAL CLASS OF BUSIMES

OO0O00E PORTFOLIO EXCEL 00000 - GEMERAL CLASS OF BUSINES
] ooo0mo PORTFOLIO Fi< 00000 - GEMERAL CLASS OF BUSIMNES
IE] 0000005 Smalown Bank 00000 - GEMERAL CLASS OF BUSIMES
] 0000012 SODIN E210 00000 - GEMERAL CLASS OF BUSINES
EI 0000007 SODIN 829 00000 - GEMERAL CLASS OF BUSIMES
] oomon sooiN &z 00000 - GEMERAL CLASS OF BUSIMES

In the Navigation pane, click a customer. The customer information appears in the Information

pane.

g Mewe Group e Refresh “ Search
E Al Cushomers
=L Banks - Barks Eumd|am|rm|km|5um| info | Desk Distrizution | Comments | Custom |
G (8 | L0006 - Smalhiovn Bank,

(-0 Coedit Card Customess - Credit Ca Code 0000008 Statuz P‘EIWE ﬂ

E-[J Schook - Schooks dlpha Code | |
Hame |Smalkown Bank |
Addiess | 3600 METERIE AVENUE |

| |
Ciy/State/Zp [ACKSONVILLE |[FL_ |[32244 |
Carlact [PaM BRIGGS |
Phone |504-555-5364 | Fase] |
Email Addiesz | |
Destinses [T
Piiiy E_ H
oK Concel | sl
L




Invoices Printable Help

3. Modify the information as necessary and then click OK.

Delete a Customer from a Customer Group
Use the Customer Groups window to delete a customer from a customer group.
To delete a customer from a customer group

1. Inthe Invoices window, from the Tools menu, click Custom Group Editor. The Customer Groups
window appears.

H Customer Groups EE
'.'_] MNew Group .e,’ Refresh “ Search
Cods | Mame Class
(=[] Banks - Banks "]  O0DODD3 BOBS HAALEYS 00001 - RETAIL
I} 000D00E - Smalkown Bank. | B51 joogo0g DEFAULT CUSTOMER 00003 - TEST CLASS OF BUSINESS
[+ __| Credit Card Customess - Credit Ce E 0000005 Eamers Bank 0001 - RETAIL
-2 Schools - Schools [F|  0DO0DD4 FRANKLIN CREDIT SOLUTIONS 00003 - STUDENT LOAMS
I 0000014 EEY FINANCLIAL CORP 00003 - STUDENT LOAMS
] 0000000 Percliz 1 00000 - GEMERAL CLASS OF BUSIMES
IF]  Do00D0Z Puticic 2 00000 - GEMERAL CLASS OF BUSINES
I 0000013 PORTFOLIO 3 00000 - GEMERAL CLASS OF BUSIMES
IE] 0000003 EORTFOLIO DELIMITED 00000 - GEMERAL CLASS OF BUSINES
I]  DO0000S PORTFOLIO EXCEL 00000 - GEMERAL CLASS OF BUSINES
I 000000 PORTFOLIO Fi= 00000 - GEMERAL CLASS OF BUSIMES
[E] 0000005 Smalbow Bark 00000 - GEMERAL CLASS OF BUSINES
L] oooooiz SODIN 8210 00000 - GEMERAL CLASS OF BUSINES
£l 0000007 SODIN 29 00000 - GEMERAL CLASS OF BUSIMES
IC]  0DDOO11 SODIN 2291 00000 - GEMERAL CLASS OF BUSINES

2. Inthe Navigation pane, right-click the customer and then click Remove Customer. The Invoices
program deletes the customer from the customer group. The customer remains in the system.

Invoices

Invoices

Use the Invoices window to specify settings and generate invoices for a customer or group of customers.

Generate an Invoice for a Specific Customer

Use the Invoice Options dialog box to specify what information to include on the invoice and then
generate the invoice for a specific customer. Before generating invoices, confirm that you processed all
payment batches using the following reports in Latitude:

e Daily Payment Report: Shows payment transactions that haven't been remitted on an invoice.
Use this report to review invoice information before actually generating or printing invoices.
This report also shows payments from a previous month that weren't included or remitted. This
report assumes that reversal matching is selected when invoicing and doesn't include Paid Us
(PU) or Paid Us Reversal (PUR) transactions for the same debtor within the same month. To
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generate the report, in the Latitude - Main Menu window in Latitude, from the Data Entry
menu, click Debtor Payments. In the Payment Entry window, from the Reports menu, click
Daily Payment Report.

¢ Payment Batch Report: Shows payment transactions that haven't been processed. To generate
the report, in the Latitude - Main Menu window in Latitude, from the Data Entry menu, click
Debtor Payments. In the Payment Entry window, from the Reports menu, click Unprocessed
Batches Report.

Note: For customers associated to a parent customer (subsidiaries), The Invoices program only
generates invoices for the parent customer.

To generate an invoice for a specific customer

1. Inthe Invoices window, in the Navigation pane, right-click a customer and then click Invoice
Customer. The Invoice Options dialog box appears, with the customer name and number at the

top.
Invoice Options .
0000004 - ABC CUSTOMER
Ivwpice Dabe

Payrment Date Rangs
* Include ol uninvosced payments
™ Inchuds papments with entesed date range of:

=] - [ =]
Ditsct Paymends
~ Bypass Disct Papmerts and do nol include them on
- the brrvosce:

{+ Inchade Direct Payments
Match PUR s [Exchade from Invaice]
[ Match the Revarzal with the Pagment thal was peversed

= Match the B eversal with any matchng payment fior the
same account

Shaterrmrt
[~ Prink Stabement with Invoice

—

Prevew |  Epot | Pirte | [[TTancal |

Invoice will be dated: Date to appear on the invoice. The date defaults to the current date. To
change the date, click the arrow and then click a date in the calendar.

Include all uninvoiced payments: If selected, the invoice includes all payments that your
organization hasn't invoiced.

Include payments with entered date range of: If selected, the invoice only includes payments
and adjustments within the specified date range that your organization hasn't invoiced. Specify
the date range or accept the default, which includes all payments and adjustments since your
organization last created an invoice for this customer. The first box is the beginning date and the
second box is the ending date.

Bypass Direct Payments and do not include them on the invoice: If selected, the invoice doesn't
include payments made directly to the customer.

20



Invoices Printable Help

Include Direct Payments: If selected, the invoice includes payments made directly to the
customer.

Match the Reversal with the Payment that was reversed: If selected, the invoice doesn't include
reversals that the Invoices program matches to a reversed payment.

Match the Reversal with any matching payment for the same account: If selected, the invoice
doesn't include reversals that the Invoices program matched to any matching payment for the
same account.

Note: If you select both check boxes, the Invoices program matches the reversal to the reversed
payment as long as your organization hasn't invoiced the reversed payment. If your
organization invoiced the reversed payment but hasn't invoiced the make-up payment, the
Invoices program matches the reversal to the make-up payment. If you clear both check boxes,
the invoice includes all payments and reversals.

Print Statement with Invoice: If selected, the Invoices program prints a customer statement
along with the invoice.

Print Statement even if Invoice has no items: If selected and the invoice doesn't have any line
items, the Invoices program prints a customer statement. If cleared and the invoice doesn't have
any line items, the Invoice program doesn't print a statement.

2. Complete the information.
3. To preview the invoice, do the following:

a. Click Preview. The invoice displays in the Invoice [Customer Code][Invoice Number] -
Latitude Report Viewer window.

B Invoice [0000002][10003] - Latitude Report Viewer | = | =
Fepot  Mew Window Heip

rvoice [000000Z][ 10003

® 3 - na -

Invoice Number: 1
Pagelofi

CIDERSYSTEST FrintDate: 412019

0000002 SECOND CUSTOMER
123 SOMEWHERE PLAZA
JACKSONVILLE,FL 32125
Am: MIKE IevoiceDaw: 472019

Naume Aczcount Number Code| PayDaw Paid Te Us Paid Te You OurFee Pt Less Fee

Bt . 5458001803115876 1 41172018 200.00 0.00 60.00 140.00
alaere 580034

Tavoice Totals 200.00 0.00 60.00 140.00

—— Dus Us:
Total Collections
Drue You:

< [ >

Current Page Moz 1 Total Page No.: 1 Zoom Factor: Page Width

Note: This window provides several options, such as exporting and printing. For more
information, see Report Viewer.
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b. Close the window.
4. To export the invoice, do the following:

a. Inthe Invoice Options dialog box, click Export. The Browse For Folder dialog box
appears.

b. Select the folder to save the file to and then click OK. The file naming convention is,
"Invoice [Customer] [Invoice Number]". If you selected the Print Statement with Invoice
check box, the Invoices program generates a statement also. The file naming convention
is, "Statement [Customer] [datetime stamp]".

5. To print the invoice, do the following:
a. Inthe Invoice Options dialog box, click Printer. The Print dialog box appears.
b. Select a printer and then click Print.

When you are finished previewing, printing, or exporting the invoice, the Status of Invoices
window appears.

(2 10003 [EENE—

Statuz of Invoices
Cusbomes Stabuz Irvvoice D Cust Duwe Uz | Currency
L O00000&-CUSTOMER FOUR | Generated 10003 $3675 30,00 USD

1 Items Processed

oy

8

6. Click the X to close the window. The Invoices program updates the Summary of Invoices tab in
the Invoices window to include the invoicing information.
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EES T oS )

Actions Tools View Reports

54 Al Customers Summary of Irvoices I Summary of Open Items |
- & D00O000-DEFAULT
S 0000001-CUSTOM 000000G6 - CUSTOMER FOUR [US Dollar)
_ & poeseipiuidiy rvoice Frequency  MONTHLY
@3 0000004-CUSTOM ""me: Method NET ‘iew Date Range
T O00005-DIALER T mvouce Type: COMBINED
L8 D000006-CLIS TOM Soit ltems By ACCOUNT NUMBER l6/3amz =] w |amiems -]
0000007-FIRST CL Last Invoice Aprl 11,2013
0000008-5ECAMD Last Inveace Attempt Aprl 11, 2013
0000003 THIRD CL -
000001 0-DISHEY € Eummaw of Invoices for 0000006 - CUSTOMER FOUR - IUSD]
0000011-ABC Cush Iryoice Gross Collections Fees Summary
Irvoice Date | SysMo| PadlUs ] Paid Cust Total Frots Eamed Due Us Due Cust
| 10003 04M1NZ| 04413 43.00 0.00 49.00 1225 0.00 xS
< | nr b
Customer Selected “0000006-CUSTOMER FOUR" Lenam | amems

._
7. To view summary information for an individual customer, in the Navigation pane, click the
customer.
Generate Invoices for a Group of Customers

Use the Invoice Options dialog box to specify what information to include on the invoices and then
generate invoices for the specified group of customers.

Note: The Invoices program only invoices customers associated to a parent customer (subsidiaries)
under the parent customer.

To generate invoices for a group of customers
1. Inthe Invoices window, do one of the following:

e To generate invoices for all customers, from the View menu, click All Customers. In the
Navigation pane, click All Customers.

e To generate invoices for customers that your organization invoices monthly, from the
View menu, click Monthly Customers. In the Navigation pane, click All Monthly
Customers.

e To generate invoices for customers that your organization invoices weekly, from the
View menu, click Weekly Customers. In the Navigation pane, click All Weekly
Customers.
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e To generate invoices for customers that your organization invoices on demand, from the
View menu, click On Demand Customers. In the Navigation pane, click All On Demand
Customers.

e To generate invoices for customers in the default customer group, from the View menu,
click Default Group. In the Navigation pane, click Default Group.

e To generate invoices for customers in a specific customer group, from the View menu,
click the group name. In the Navigation pane, click the group name.

From the Action menu, click Invoice All. The Invoice Options dialog box appears, with the name
and number of the first customer in the group at the top.

Invoice Options .
- DEFAULT CUSTOMER
Inncace Diate
Irvvoice will be dated: [Sslect date) | 4./1./2M9 -
Fapment Dabe Range

% Inchade all unirvoced payments
™ Inchade paymerds with entered date 1ange of

Direct Papments
~ Bypass Dwect Payments and do not inchude them on
the | nvioice

i Include Dinect Payments

Match PURs (Exchede from Irvece)
W Match the Reversal with the Papment that was ieversed

= Match the Reversal with any malching payment Iod the
same sccount

Statement
[T Print Stabement with Irvoice
=

Preview |  Expot | Pinies Cancel |

™ Use these settings for all Invoices in this run

Invoice will be dated: Date to appear on the invoice. The date defaults to the current date. To
change the date, click the arrow and then click a date in the calendar.

Include all uninvoiced payments: If selected, the invoice includes all payments that your
organization hasn't invoiced.

Include payments with entered date range of: If selected, the invoice only includes payments
and adjustments within the specified date range that your organization hasn't invoiced. Specify
the date range or accept the default, which includes all payments and adjustments since your
organization last created an invoice for this customer. The first box is the beginning date and the
second box is the ending date.

Bypass Direct Payments and do not include them on the invoice: If selected, the invoice doesn't
include payments made directly to the customer.

Include Direct Payments: If selected, the invoice doesn't include payments made directly to the
customer.
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Match the Reversal with the Payment that was reversed: If selected, the invoice doesn't include
reversals that the Invoices program matches to a reversed payment.

Match the Reversal with any matching payment for the same account: If selected, the invoice
doesn't include reversals that the Invoices program matched to any matching payment for the
same account.

Note: If you select both check boxes, the Invoices program matches the reversal to the reversed
payment as long as your organization hasn't invoiced the reversed payment. If your
organization invoiced the reversed payment but hasn't invoiced the make-up payment, the
Invoices program matches the reversal to the make-up payment. If you clear both check boxes,
the invoice includes all payments and reversals.

Print Statement with Invoice: If selected, the Invoices program prints a customer statement
along with the invoice.

Print Statement even if Invoice has no items: If selected and the invoice doesn't have any line
items, the Invoices program prints a customer statement. If cleared and the invoice doesn't have
any line items, the Invoice program doesn't print a statement.

Use these settings for all Invoices in this run: If selected, the Invoices program applies these
settings to all the customers. If cleared, the Invoices program displays the Invoices Options dialog
box for each invoice to allow you to specify settings for each customer.

3. Complete the information.

4. To preview the first invoice in the group, do the following:

a. Click Preview. The invoice displays in the Invoice [Customer Code][Invoice Number] -
Latitude Report Viewer window.
r Invoice [0000002][10003] - Latitude Report Viewer | = | =

Bepot  Mew Wndow Hep
Trrviece [O0C002] 10000

P 5 % - XL

Invoice Number:
Pagelofi

CIDERSYSTEST FrintDate: 412019

800 Parkwsy

0000002 SECOND CUSTOMER
123 SOMEWHERE PLAZA S04-
JACKSONVILLE,FL 32125
Am: MIKE IevoiceDaw: 472019

Naume Aczcount Number Code| PayDaw Paid Te Us Paid Te You OurFee Pt Less Fee

DODDIE, JULIE $455001803115876

200.00 0.00 60.00 140.00
Saee BP0

Tavoice Totals 200.00 0.00 60.00 140.00

T— Dus Us: §0.00
Total Collections 200.00
Drue You: 200.00
< [ >
Current Page Moz 1 Total Page No.: 1 Zoom Factor: Page Width
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Note: This window provides several options, such as exporting and printing. For more
information, see Report Viewer.

b. Close the window.

c. Toview the next invoice, close the window and, in the Invoice Options dialog box, click
Preview.

5. To export the first invoice in the group, do the following:

a. Inthe Invoice Options dialog box, click Export. The Browse For Folder dialog box
appears.

b. Select the folder to save the file to and then click OK. The file naming convention is,
"Invoice [Customer] [Invoice Number]". If you selected the Print Statement with Invoice
check box, the Invoices program generates a statement also. The file naming convention
is, "Statement [Customer] [datetime stamp]".

c. To export the next invoice, in the Invoice Options dialog box, click Export.
6. To print the first invoice in the group, do the following:
a. Inthe Invoice Options dialog box, click Printer. The Print dialog box appears.
b. Select a printer and then click Print.
c. To print the next invoice, in the Invoice Options dialog box, click Printer.

When you are finished previewing, printing, or exporting the invoices, the Status of Invoices
window appears.

E 10010 =2

=7
Status of Irvvoices
. Custormes | Status | lrvoice | Due Cust ] Due Us | Cumency ]
b | DOOOOOODEFALLT CLSTOMER | No Ibems | Mot Invoiced | . |
| D000001FIRST CUSTOMER | Gerersted (10008 | $10000 45000 USD
0000002-SECOMD CUSTOMER _Genelded I'||:l:l:|':'l | L\-.]Jlfl'_'ll ﬁJJIili‘IILI'SU
0000003 THIRD CUSTOMER Genersted 10010 | $15000,  $0.00 USD
| 0000004480 CUSTOMER Mo Ierns Mot Irrvoiced

5 Items Processed

7. Click the X to close the window. The Invoices program updates the Summary of Invoices tab in
the Invoices window to include the invoicing information.
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OOOO0O0-DEFALILT
OOOOOT FIFST CL ANl Customers
DO0O00Z-SECOND : 1
QKON THIRD £ |
OO0O04-ABC CLIS I Ve (oo R
1 [vmmms =] o [as12m =]
......................................................... |
|
|
Irrerica (Gezan Colschions Feet Smmary -
roce | Date [Spbo] PsdUs [ PsdCit | TowiPmis | Eamed Duels | DueCus
1000 (43| A 000 000 WO00 15000 o 1500
00 | MANATE] A | 10000, 0| 0K S0 5000 10000
-
" > 7
Customer Group Setschad "4l Customen™ 259PW | anams

8. To view summary information for an individual customer, in the Navigation pane, click the
customer.

Undo the Last Invoice Generated

Use the Invoices window to undo the last invoice generated. This option allows you to correct items on
an invoice and then regenerate the invoice. If you generated invoices for a group of customers, the
Invoices program reverts the last invoice in the group. You can repeat these steps to undo as many
invoices as necessary. To undo a specific invoice, see Undo a Specific Invoice.

To undo the last invoice generated

1. Inthe Invoices window, from the Actions menu, click Undo Last Invoice. A confirmation dialog
box appears.

Undo Invoice 10003
Dated 4/11/2013

Customer 00000063

=]

2. Click Yes. A notification dialog box appears.

3. Click OK.
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Undo a Specific Invoice

Use the Summary of Invoices tab in the Invoices window to undo a specific invoice. This option allows
you to correct items on an invoice and then regenerate the invoice. Undoing an invoice doesn't undo
checks that you printed. If you printed checks, delete them from the check register. For more
information, see Delete a Transaction From the Check Register.

Note: The data grid includes invoices for parent customers only. If you select a child customer, the
Invoices program displays the parent customer number to reference.

To undo a specific invoice

28

1. Inthe Invoices window, in the Navigation pane, click the customer or invoicing group for which
to display invoices.

2. Click the Summary of Invoices tab.

E] Latitude Inveices (Versicn 10.10.76) | = o

Achors  Took Veew Repods

= Summany of brrvoxces | Summary of pen e |
OOCOOOC-E FALILT
DO0000T FFST CL Al Customers
OOOOOOE-SECOND
DO THIRD 01 i i
DOCO0M-ABLT CLUS . | Wirwr [abe Rlarge
[1meme =] o [er1om8 =]
Consoldabed Surmmany of Irvoes tor 88 Dislomer: - [USD)
Irrwoice | {Gecan Collections T Fees Summary =
e | Date [SpMa] Psdus | PesdCist Tl Py E mmed Dl | DueCom |
k{10090 04153 43 3000 Q00 300 00 V5000 0o 150000
- |wom [mas] s | 2000 a0 6000 B0 2000
L] T3 A3 1000 ano 10 0 50.00 S0 100u00
w
| < L > o

Customes Group Gedacted "Bl Customen” 253 PM 4N/ANE

3. To change the date range for which to display invoices, click the arrow next to the date range

boxes and click a beginning and ending date.

4. Inthe data grid, right-click the invoice and then click Undo Selected Invoice. The Undo

Invoice(s) dialog box appears.

Tip: To select multiple sequential invoices, press and hold the Shift key and click the first and
last sequential invoice. To select multiple non-sequential invoices, press and hold the Ctrl key
and click each individual invoice. Click Undo All Selected.
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Are you sure you want to unde:

1 Irvvoice(s)

[ v |

5. Click Yes. A notification dialog box appears.
6. Click OK.

Reprint an Invoice
Use the Summary of Invoices tab in the Invoices window to reprint an invoice.

Note: The data grid includes invoices for parent customers only. If you select a child customer, the
Invoices program displays the parent customer number to reference.

To reprint an invoice

1. Inthe Invoices window, in the Navigation pane, click the customer or invoicing group for which
to display invoices.

2. Click the Summary of Invoices tab.

OODOOO0-DEFALILT
DO00O0TFIRST CL Al Cunbomers
DO0000Z-SECOND : ]
DO0000Z- THIRD C1 i
DODDOCH-ABC CUS I Vinws [abe Flargn
1 [vmmams =] w[as12m =]
......................................................... |
|
|
R T e s [ e g e
Irregice {Geoan Collechions Fess Smmary -
Woice | Date [Spis] Psdls | PsdCst | TowlPms | Esmed Duslls | DusCum
¥ 1000 A3 | 0413 000 000 WO00 15000 0o 150,00
00E | ] 048 | 10000, [T MO0K 5000 5000/ 100,00
3
- > o
Custnmer Group Silactact Al Customn” 258PH | 4n/Me

3. To change the date range for which to display invoices, click the arrow next to the date range
boxes and click a beginning and ending date.
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4.

In the data grid, right-click the invoice and then click Reprint Selected Invoice.

Tip: To select multiple sequential invoices, press and hold the Shift key and click the first and
last sequential invoice. To select multiple non-sequential invoices, press and hold the Ctrl key
and click each individual invoice. Click Reprint All Selected.

Do one of the following:

To preview the invoice before reprinting, click Preview. The invoice appears in the Report
Viewer window. For more information, see Report Viewer.

To print the invoice without previewing it first, click Printer.

Specify Default Invoicing Options

Use the Options dialog box to specify default invoicing options for your agency. These settings apply
globally.

To specify default invoicing options

1.

30

From the View menu, click Options. The Options dialog box appears.

= Options | x|
Cuztomers with balance: dus

[w Adpst Remittance Checks. - Apply To Didast First
When an Irvaice ie crealed, if the Cuglamer has outstanding Oper lbems due, offsst
arw check bo be created by the amaurt due fiom the Customer

Paymeart D abe Salection
& Select by the Papment Entered date.
" Selact by the Papment Dabte-Pad date. [Mot recommended]
Revarzal Malching
[w Match Aeverzals with B onginal payment and do not irvoice either papment
[w Blatch Aeverzals with the paymert that covers it
If both boxes ame checked the reverzal will be matchad wath the onginal papment az long as the
onginal paement hat ot bean invaiced. IF the aigingl papment haz beean irvaicad the program
wail malch e revverzal wilh the make-up payment if thal has nol pet besn imaoiced.

Logoing
[T Enable Logging

Save Dptions | E st |

Adjust Remittance Checks: If selected, the Invoices program deducts from the checks created in
the Invoices program the outstanding open items due from customers. The Invoices program
reduces the invoice totals by the amount applied to outstanding accounts receivable items and
prints another summary line on invoices to show the amount applied.

Apply to Oldest First: If selected, the system applies payments to the oldest accounts receivable
balance first. This option is available when you select the Adjust Remittance Checks check box.

Select by the Payment Entered Date: If selected, the invoice includes payments based on the
date a user added the payment to Latitude.
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Select by the Payment Date - Paid date: If selected, the invoice includes payments based on the
date paid.

Match Reversals with the original payment and do not invoice either payment: If selected, the
Invoices program matches reversals to the reversed payment and doesn't invoice either
transaction.

Match Reversals with the payment that covers it: If selected, the Invoices program matches
reversals to any matching payment for the same account and doesn't include them on invoices.

Note: If you selected both check boxes, the Invoices program matches reversals to the original
payment as long as your organization hasn't invoiced the original payment. If your organization
invoiced the original payment and hasn't invoiced the make-up payment, the Invoices program
matches the reversals to the make-up payment. If you cleared both check boxes, the invoice
includes all payments and reversals.

Enable Logging: If selected, the Invoices program creates the "Invoices.log" file in the C:\Program
Files (x86)\Latitude Software\AuditLogs directory. It contains any error messages generated in
the Invoices program. You can send this file to Latitude by Genesys Support for assistance in
troubleshooting invoicing issues.

2. Complete the information and then click Save Options.

Modify Invoicing Options
Use the Customer Properties window to modify a customer's invoicing options.
To modify invoicing options

1. Inthe Invoices window, in the Navigation pane, right-click a customer and then click Properties.
The Customer Properties window appears.

8 Customer Properties: 0000001 CUSTOMER ONE i

Gereral |-¢u:|:.uur1| Fees | Invoice | Services | Info | Desk Distribution | Curnm:nlsl l:u:l-lur'1|

Email Address |I:-arl:-a'a martindBinin.com

Cade 0000001 Stahss |ACTIVE |
AlphaCode | |
Mame CUSTOMER OME |
Addass [123 MAIN STREET |
[SLITE 100 |

Ciy/Stale/Zp | JACKSONVILLE L |[32246 |
Cantact [HMT ]
Phare [FE1212 | Faxl |
|

Diefaul Interes! ||:' |

Pririty 10 :l
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2. Click the Invoice tab.

8 Customer Properties: 0000001 CUSTOMER ONE [

Grncrall Account | Fees |I'l'-"0m'=| Services | Info | Desk Distribubion | Comments | Cualnml

Parent Customer  j0000001 - CUSTOMER ONE ﬂ
Irvoice Type |2 - COMBINED ] W Show Date Received
e oo |J{-MEII"-ITHLY T| [~ Show Othet Name
. ¥ Show Amourt Due Client
Irnvoice Method |1 -MET j
|2 CUSTOMER ACCOUNT J ¥ Show Curment Balance
Irnvnice Sor . -
fiveiEs = [ Show Qrigingl Dale on Reversals
Romi Method  |Check =]

Mumbes of days to allow papments by check bo clea I—_|
befiore mchiding them on an invoice L

Crystal Repoel fssocistions

Invoce F|'D|:Il:II|: |E¢:i|;|n'.rnl;|_-,. ipt -

K | Coeel | |

e A

Parent Customer: If your organization bills the customer as part of a parent company, click the
folder to select a customer group.

Invoice Type: Determines the invoicing method for payment types.
e Separate: Creates separate invoices for each payment type.
e Combined: Includes all payment types together (combined) in one invoice.

Note: If you set the Invoice Type to Combined, PC (direct), the Invoices program includes
payments in the fees withheld. If you set the Invoice Type to Separate, PC (direct), the Invoices
program creates payments as open items for the invoice.

Invoice Frequency: Determines how often to send invoices to the customer.
Invoice Method: Method for invoicing the customer.
e Net: Subtracts your organization's fee from the customer invoice.

e Gross: Sends customer invoices with all monies included. The customer pays your fee
based on the invoice information.

Invoice Sort: Order to sort the invoices.

Remit Method: Determines the method for remitting invoices. Invoice transactions appear in the
check register automatically for customers with a remittance method of "check" or "ACH
transfer." If the remittance method is "manual," add the invoice transactions to the check register
manually.

e Manual: Your agency manually generates checks for the customer.

e Check: Your agency uses the Invoices program to print checks for the customer.
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e ACH Transfer: Your agency uses the Invoices program to create ACH wire transfers for
the customer.

Show [check boxes]: If selected, the corresponding information prints on the customer's invoices.

Number of days to allow payments to clear before including on invoice: Number of days to wait
before including debtor payments on a customer invoice. If the debtor’s check does not clear, use
this option to avoid sending payment information to a customer.

Invoice Report: Crystal Reports file to use when creating invoices for the customer. This option
allows you to use custom invoices for each customer. The default file is Basiclnvoice.rpt. Import
the reports into Latitude to make them available for selection from the list box.

3. Modify the settings as necessary and then click OK.

Report Viewer

Use the Report Viewer window to view and print a report, invoice, or customer statement. The Report
Viewer window appears when you:

e Generate areport.
e Generate or reprint an invoice.
e Preview a statement.

The following example is for a report.

|i'| Invoice Summary - Report Viewer I =& ﬁ
] 1 n M M-
Summary of Invoices
All customers for system month 04,2013 |
ReportDate: 4/11/2013 1
Invoice(s) Pad Us Pasd Cust  Collechons Fasg DueUs Due Cust Currency
0000001 CUSTOMER ONE 10004 4 460 88 0.00 4 460 88 111322 0.00 31,345 66 UsD
0000006 CUSTOMERFOUR 10006 49.00 0.00 49.00 12.25 0.00 36.75 UsD
4,500.88 0.00 4,509.88 L12747 0.00 338241
' nr 2
Current Page No.: 1 Total Page Ne.: 1 Zoom Facter: Page Width
Icon Description
e Exports the report to a file.
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Icon Description

“H Prints the report.

4 Displays the first page of the report.

L | Displays the previous page of the report.

2 Displays the next page of the report.

b Displays the last page of the report.
1/1 Indicates the report page currently displayed and the total number of pages in the report.
i Opens the Find Text dialog box to allow you to search for text within the report.

o - Increases or decreases the text size when viewing the report on your monitor. Changing the

text size here does not affect the size of the text on the printed report.

Statements

Statements

Use the Invoices window to preview and print account statements for a customer or group of
customers. Account statements show a customer's receivables by invoice.

Generate a Statement for a Specific Customer
Use the Report Viewer window to generate a statement of account for a specific customer.
To generate a statement for a specific customer

1. Inthe Invoices window, in the Navigation pane, right-click the customer and then click
Generate Statements.

2. Do one of the following:

e To preview the statement before printing it, click Preview. The statement of account
appears in the Report Viewer window.
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-
|#] Statement for 0000001 - Report Viewer miel=k

Summary or Items by Age:
Less than 30 days old 0.00
311060 daysold 0.00
61 to 90 davs ald 0.00
Over 90 davs old 0.00
Total Amount Diue: 0.00 .
‘ m L3
Current Page No.: 1 Total Page No.: 1 Zoom Factor: Page Width

i | ! 1 i & -

Interactive Intelligence, ARM Division

7800 BELFORT PARKWAY
SUITE 100 |
JACKSONVILLE, FL 32256 5

Statement of Account

CustomerMNumber: 0000001 Statement Date:  April 11, 2013
CUSTOMER ONE For Customer Inquines contact:
Attn: MATT
123 MAIN STREET Phone: 204-680-7100
SUITE 100 Toell Free: 866-306-2509

JACKSONVILLE, FL 32246

For more information about using the Report Viewer window, see Report Viewer.

e To print the statement without previewing it first, click Print. The statement of account is output
to your default printer.

Generate Statements for a Group of Customers

Use the Report Viewer window to generate account statements for a group of customers.

To generate statements for a group of customers

1. Inthe Invoices window, do one of the following:

To generate statements for all customers, from the View menu, click All Customers. In
the Navigation pane, click All Customers.

To generate statements for customers that your organization invoices monthly, from
the View menu, click Monthly Customers. In the Navigation pane, click All Monthly
Customers.

To generate statements for customers that your organization invoices weekly, from the
View menu, click Weekly Customers. In the Navigation pane, click All Weekly
Customers.

To generate statements for customers that your organization invoices on demand, from
the View menu, click On Demand Customers. In the Navigation pane, click All On
Demand Customers.

To generate statements for customers in the default customer group, from the View
menu, click Default Group. In the Navigation pane, click Default Group.
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e To generate statements for customers in a specific customer group, from the View
menu, click the group name. In the Navigation pane, click the group name.

2. From the Action menu, click Generate Statements.

3. Do one of the following:
e To preview the statement before printing it, click Preview. The account statements

appear in the Report Viewer window. A tab appears in the window for each customer
statement.

3 s v S - o=

Bepot  Miew Window Help

Statement for 0000006 | Statement for 0000007 000001}
for 0000008 | S for 0000010 | 0000000 | Siatement for 0000001 | Statement for 0000003 | Statement for 0000004 | Statement for 0000005
I ] 1 n #od-

Interactive Intelligence, ARM Division A

T800BELFORT PARKWAY
SUITE 100
JACKSONVILLE.FL 32256

Statement of Account

Customer Number: 0000011 Statement Date:  Apgl 11, 2013
ABC Customer For Customer Inquiries contact :
Artn: Mr. Smith
555 Main St. Phone: 904-680-7100
Jacksonville, FL 32224 Toll Free: 866-396-2599

Summary or Irems by Age :

Iese than 30 daws nld N
b

F

Current Page Mo.: 1 Total Page MNo.: 1 Zoom Factor: Page Width

For more information about using the Report Viewer window, see Report Viewer.
e To print the statements without previewing them first, click Print. The account

statements are output to your default printer.

Report Viewer

Use the Report Viewer window to view and print a report, invoice, or customer statement. The Report
Viewer window appears when you:

e Generate areport.
e Generate or reprint an invoice.
e Preview a statement.

The following example is for a report.
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e e e e

@ B 1 nw -

Summary of Invoices
All customers for system month 042013

Report Date: 4/11/2013

Invoice(s) Paid Us Pasd Cust  Collecnons Fesg DueUs Due Cust Currency

0000001 CUSTOMER ONE 10004 4 460 88 0.00 4 460 88 111522 0.00 3,345 66 UsD

0000006 CUSTOMERFOUR 10006 49.00 0.00 49.00 12.25 0.00 36.75 UsSD
4,509.88 0.00 4,509.88 112747 0.00 338241

L n k
Current Page No.: 1 Total Page No.: 1 Zoom Factor: Page Width
& _—

Icon Description

@ Exports the report to a file.

“H Prints the report.

L Displays the first page of the report.

4 Displays the previous page of the report.

3 Displays the next page of the report.

b Displays the last page of the report.
1/1 Indicates the report page currently displayed and the total number of pages in the report.
# Opens the Find Text dialog box to allow you to search for text within the report.

o - Increases or decreases the text size when viewing the report on your monitor. Changing the

text size here does not affect the size of the text on the printed report.

Transactions

Transactions

Use the Summary of Open Items tab in the Invoices window to view outstanding invoices (receivables)
for the specified customer or group of customers. You can view payment and adjustment transactions
and post them to the invoices.
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View Payment and Adjustment Transactions

Use the Summary of Open Items tab in the Invoices window to view payment and adjustment
transactions by invoice for a customer.

Note: The data grid includes invoices for parent customers only. If you select a child customer, the
Invoices program displays the parent customer number to reference.

To view payment and adjustment transactions

1. Inthe Invoices window, in the Navigation pane, click the customer or invoicing group for which
to display invoices.

2. Click the Summary of Open Items tab.

Summany of Invoices  Summary of 0pen llems I

" 0000001 - JACKSONVILLE BANK. (US Dollar)

nvoice Frequency.  Monthly
rvioice Method GROSS

FWND“HW ......................................
nvore Tppe SEPAFATE
Py T— ACTOUNT HUMBER hzirzzo0 =] o hznazam  =|
T ST | e e AT R AT )

L_asl lpvoace Atterapt  Decersber 13, 2017

Summary of Oper [tams for 0000001 - JACKSOMVILLE BANE - [USD]

Invoice Amounts
I-Il.mbﬂ] Date DEE_"!- ! Dl.ll.lkl LutFa'dI Current Duse
4 140 121311 20873 | 20973
183 110111 20,00/ | 2000
1mez2 1101711 741.30 | T41.30
10168 08/25/11 521.34] | 521.34.
10164 05/25M1 1.112M | 1.113m
10130 nAsnt | 1675 o321 -1,000.00
- s ______ mAem 2w 21010
10120 01/06/11 800,00/ NLEGIN 0.00
I 10118 0611 20000 mAe | 0.00
10104 12/16/10. s o1/08/11 | 0.00
I 10080 12/03/10 655,08 01/06/11 | 0.00
Selected: “0000001JACKSONVILLE BANK" 319PM 127192011

3. To change the date range for which to display invoices, click the arrow next to the date range
boxes and click a beginning and ending date.

4. In the data grid, right-click the invoice and then click View Transactions. The Open Item
Transactions dialog box appears.

Tip: To select multiple sequential invoices, press and hold the Shift key and click the first and

last sequential invoice. To select multiple non-sequential invoices, press and hold the Ctrl key
and click each individual invoice.
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E= open Item Transactions Bl = |m| |ﬂ
Custorner: 0000001 Invaice: 10190
JACKSOMNVILLE BAME g
BODD Bajreadns Way Cicated Decenber 13, 200
Jechsonvile, Fl 32256
Opermng Balance 20973 [USD]
Contact  JAMES SRCWHN
Fhone: 9045351000 Curent Balance 209.73 [USD)
Transactions [USD)
Date | Transaction Desciption | Code | Debis [+ Credits -]
b 1241 32011 | Dlaeping Balanze Open 208,71
Prirk Mam Trarsaction | Exit

5. To print the information, click Print. In the Print dialog box, modify the settings as necessary and
then click Print. The information is output to the specified printer.

6. To post another transaction to the invoice, click New Transaction.

7. To close the dialog box, click Exit.

Post a Transaction to an Invoice

Use the New Open Item Transaction dialog box to post payment and adjustment transactions to an
invoice.

Note: The data grid displays invoices for parent customers only. If you select a child customer, the
Invoices program includes the parent customer number to reference.

To post a transaction to an invoice

1. Inthe Invoices window, in the Navigation pane, click the customer or invoicing group for which
to display invoices.

2. Click the Summary of Open Items tab.
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» S0l w2y 287 | 2873

10182 11001 30 | X
o el 052541 ndol | 111301
=

{ _________was  mosem 20000 | 21010
=
,___EEE-IEEEH_EJ
~J1 _ woso| 120310 68508  oeM| 000

3. To change the date range for which to display invoices, click the arrow next to the date range
boxes and click a beginning and ending date.

4. Inthe data grid, right-click the invoice and then click Post Transaction. The New Open Item
Transaction dialog box appears, with the invoice number at the top of the dialog box.

Tip: To select multiple sequential invoices, press and hold the Shift key and click the first and
last sequential invoice. To select multiple non-sequential invoices, press and hold the Ctrl key
and click each individual invoice.
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New Open Item Transaction BRI g
1man Cument Balance: 2E T
00000C - JACKSOMVILLE BAME Curency =D
Select Trarzaction Type——
i+ Payment Received ™ Decreasing Adjuztment
™ Paymeni Reverzal ™ Increzzing Sdjuztment
Seect Transaction Date Tienzaction dmount in S0
12/19/2011 'I | 100.00
Caomment [Optional

|Pavnent Received

o | _ome | [Cew]

5. Inthe Select Transaction Type section, click the transaction type to post.
6. Inthe Enter Transaction Amount box, type the transaction amount to post.

7. Inthe Comment box, type a comment to include on the statement (optional) and then click
Accept.

Check Register

Check Register

Use the Check Register window to generate checks or Automated Clearing House (ACH) transactions for
your customers and keep a record of all bank transactions for your agency’s trust accounts. Invoice
amounts show in the check register for those customers configured to allow checks or ACH transactions
for remittance.

Add a Transaction to the Check Register

Use the New Bank Entry dialog box to add a transaction to the check register.

To add a transaction to the check register

1. Inthe Invoices window, from the View menu, click Check Register. The Check Register window
appears.
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Bomimar I
Actions
Select Bank Account
[00000 - Gereral Trust (USD) =l ‘ | New Entp | |
Wiew Filless Curient Accoun] Balance
Show Tranzaction Typs — Tranzaction Date Range ——
& Tranzactions = J3men3 «| w|4n52013 -] -36.75 usp
Sedected Ertries
Date Ch Mumbes Description IR Debitémt(+) | Credtmt[] |
Type [Printed Memo
p | 4117203 CUSTOMER FOUR 1N $0.00 $36.75]
ACH Out Irwoice(z] 10009 i
Total [USD] | $0.00} $36.75|
Print Al Repint Selscted | | Show ACHiedo Edil Stocks ] Exi |

2. Click New Entry. The New Bank Entry dialog box appears.

NewBankEntryinUSD =
— 00000 - General Trust
— Select Entry Type
= Check " Deposit
£~ ACH Transfer Dut " ALCH Transfer In
i Semvice Charge " Beturned lem
~ Decreasing Adjustment (™ Incressing Adustment
Tranzaction Dezcnobion [Optional] Amount (IS0
0.an
Memo [Dptional]
Private Mobe [0 ptional)

Eritesr E sk

3. Inthe Select Entry Type section, click the transaction type.
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In the Transaction Description box, type a description of the transaction.
In the Amount (USD) box, type the transaction amount.
In the Memo box, type more information regarding the transaction.

In the Private Note box, type information that you want available internally only. This
information doesn't appear on checks or reports to the customer.

Click Enter. A notification dialog box appears.

Click OK.

10. In the New Bank Entry dialog box, click Exit.

View Transactions in the Check Register

Use the Check Register window to view transactions in the check register.

To view transactions in the check register

1.

In the Invoices window, from the View menu, click Check Register. The Check Register window
appears.

r '
LSS e
Actions
Select Bank Account r
| 00000 - Gereral Trust (USD) -] | Jewe Eriay |
Wiew Filless - Curient Accourt Balance
Show Tranzaction Typs l—TrmBal::tnn Date Range —
|8 Transactions =~ |amem3 =] o [4ns2m3 =] -36.75 UsD
Sedected Erfries
Date Ck Murnbet Deccrption R | Debktmifs) | Credtémt(] |
Type [Printed Memo
p | 1172013 CUSTOMER FOUR I $0.00 $36.75]
ACH Out Invaice(z] 10003 - 1
Total (USD)| $0.00 $36.75|
Prirt All Repiint Select 5 how ACHads Edit Stacks | Est |
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2. Inthe Select Bank Account list box, click the bank account for which to view transactions. If you
don't have a check template associated to the bank account, the Invoices dialog box appears.

' R
[nvaices ﬁ

This Bank Account does not have a Check Stock assooated. Click OK to select or
design a new Check Stock.

QK Cancel
3. Do the following:
a. Click OK. The Check Stock Editor window appears.
b. In the list box under the check sample, click the template name.

C. Click Accept Settings and then click Exit.
4. In the Show Transaction Type section, click the type of transactions to view.
5. Inthe Transaction Date Range section, type the beginning and ending transaction date to view.
Transactions that meet the specified criteria appear in the Selected Entries data grid.
Delete a Transaction From the Check Register
Use the Check Register window to delete a transaction from the check register.
To delete a transaction from the check register

1. Inthe Invoices window, from the View menu, click Check Register. The Check Register window
appears.
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r '
ELSSI e
Actions
Select Bank Account T
[00000 - Gereral Trust (USD) ] | New Entp |
Wiew Filless - Curient Accourt Balance
Show Tranzaction Typs l—Tramal::b:n Date Range —
[ Transactions = J3men3 «| w|4n52013 -] -36.75 usp
Sedected Ertries
Date Ch Mumbes Description IR DebitAmt(+) | Credtamt(] |
Type [Printed Memo
p | 1172013 CUSTOMER FOUR I $0.00 $36.75]
ACH Dut Invoice[z) 10009
Total [USD] | $0.00] $36.75]
Prirt All Repint Select Show ACHtads Edit Stocks | Esdl |

2. In the Select Bank Account list box, click the bank account for which to view transactions.

3. Inthe Show Transaction Type section, click the type of transactions to view.

E

In the Transaction Date Range section, type the beginning and ending transaction date to view.
Transactions that meet the specified criteria appear in the Selected Entries data grid.

In the data grid, click the transaction to delete.

5
6. Right-click the transaction and then click Delete. A confirmation dialog box appears.
7. Click Yes. A notification dialog box appears.

8

Click OK.

Create or Modify a Check Template

Use the Check Stock Editor window to create or modify a check template to use when you print checks.
The Invoices program includes a standard check template. You can modify this template or create your
own. You can use any standard 8 % x 11 paper stock that prints 3 checks per page.

To create or modify a check template
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1. Inthe Invoices window, from the View menu, click Check Register. The Check Register window

appears.

CECSIES )

Achions
Select Bank Account
[00000 - Gereral Trust (USD) =l ‘ | New Entp |
Wiew Filless Curient Accoun] Balance
Show Tranzaction Typs — Tranzaction Date Range ——
| Transactions R N ETREE S EE R -36.75 usp
Selected Erines
Date Ch Mumbes Description |r DebkAmt(+] | Credtémt(] |
Type [Printed Memo
p | 41172013 CUSTOMER FOUR 1N $0.00 $36.75]
ACH Out Invoice(z] 10009 i
Total (USD] | $0.00] $36.75|
Prink &l Riepiint Selected | ShowACHtodo EdtStocks | Bt |

2. Click Edit Stocks. The Check Stock Editor window appears.
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H| §l<Dobar Amkrel
i i k| Digllaiz
HE ) E‘
e = [Endorzement i ieu of Signature)
Memo [z Memn Fiekd»|
3
014250 t063014495¢ 12345678900

To create a check template, click New. The Invoices program clears the layout settings to allow

you to specify settings for the new template.

To modify a label on the check (for example, Number or Date), do the following:

Double-click the label. The Label Edit dialog box appears.

Fort Size  Font
[8.25 »| |MS Sans Sent - B u| ;|

Text
M e

Thiss hed ill Be ptivited i the fonl style selected iF the lem iz enabled,

Font Size: Label font size.

Font: Label font style.
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10.
11.

12.
13.

B: Click to bold the label.
U: Click to underline the label.
I: Click to italicize the label.
Text: Label text.
b. Modify the information as necessary and then click OK.

To exclude a label from printing on checks, right-click the label and then click Disable this field.
The label is gray.

To include a label so that it prints on checks, right-click the label and then click Enable this field.
The label is no longer gray.

To change the location of a label, click the label and drag it to the location you want and then
release your mouse button.

To change the check size, click the square in the lower right-side corner of the check and drag it
to the width and height you want. Use the rulers as a guide. The Invoices program moves the
magnetic code strip so that it appears in the lower section of the check.

To change the number of checks to print per page, click in the Layout box.

If you're creating a template, in the template name list box, type a name for the template.
To print a grid on the background of the check, in the Grid section, do the following:

In the Size list box, click the size of the grid.

To set the grid color, in the Red, Green, and Blue boxes, type or click the color mix.

To print a check sample so that you can verify the layout settings, click Test Print.

When the layout settings are correct, click Accept Settings and then click Exit.

Specify a Check Template

Use the Check Stock Editor window to specify the check template to use when printing checks.

To specify a check template

48
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In the Invoices window, from the View menu, click Check Register. The Check Register window
appears.
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Actions
Select Bank Account
[00000 - Gereral Trust (USD) =l ‘ | New Entp | |
Wiew Filless Curient Accoun] Balance
Show Tranzaction Typs — Tranzaction Date Range ——
& Tranzactions = J3men3 «| w|4n52013 -] -36.75 usp
Sedected Ertries
Date Ch Mumbes Description IR Debitémt(+) | Credtmt[] |
Type [Printed Memo
p | 4117203 CUSTOMER FOUR 1N $0.00 $36.75]
ACH Out Irwoice(z] 10009 i
Total [USD] | $0.00} $36.75|
Print Al Repint Selscted | | Show ACHiedo Edil Stocks ] Exi |

2. Click Edit Stocks. The Check Stock Editor window appears.
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s T )
wauvm& Mumber [<Check. Nox»|

own. US 32212 Date:  k<Date Field:>|

H| §l<Dobar Amkrel
53] Digllaiz

— 2

[Endorzement i ieu of Signature)

Memo [z Memn Fiekd»|
3
014250 1063014400t 123456783900
_
T T T " T T "1 " T "1 T "1 " T "7 " T " 1"17"7
ML L I I I L R
Layout
<l
1
2 Girid
] Size Aed Grean Blue
.|':”f s [ H T H T3
New | msm| Test Print ] Ext

3. Inthe list box under the check sample, click the template name.

4. Click Accept Settings and then click Exit.

Print Checks

Use the Check Register window to print all checks in the check register that your organization hasn't
printed yet. Ensure that you have the magnetic cartridge used for checks installed in your printer and
the correct paper stock in the paper tray.

To print checks

1. Inthe Invoices window, from the View menu, click Check Register. The Check Register window
appears.
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In the Select Bank Account list box, click the bank account for which to view transactions.
In the Show Transaction Type section, click the type of transactions to view.

In the Transaction Date Range section, type the beginning and ending transaction date to view.
Transactions that meet the specified criteria appear in the Selected Entries data grid.

Click Print All. The Print dialog box appears.

Modify the settings as necessary and then click Print. The Check Print Options dialog box
appears.
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Check Print Options
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Do one of the following:

o If the check paper doesn't have pre-printed numbers, click The Check Stock does not
have pre-printed numbers. The system prints the check numbers on the checks, starting
with the next sequential number after the last check number used. The system also

records the check numbers in the check register.

e For pre-numbered check paper, click Check stock is pre-numbered and the next
number is: and then, in the box, type the starting check number. The Invoices program
doesn't print the check numbers on the pre-numbered check paper. The Invoices
program does use the check number you type in the box to record the check numbers in

the check register.

Click OK. The Invoices program prints the checks. The Invoices program records the date printed
and the check numbers in the Selected Entries data grid. The Invoices program assigns check

number "1000" to checks without a check number.

Reprint a Check

Use the Check Register window to reprint one or more checks. Ensure that you have the magnetic
cartridge used for checks installed in your printer and the correct paper stock in the paper tray.

To reprint a check
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2. In the Select Bank Account list box, click the bank account for which to view transactions.
3. Inthe Show Transaction Type section, click Checks.

4. In the Transaction Date Range section, type the beginning and ending transaction date to view.
Transactions that meet the specified criteria appear in the Selected Entries data grid.

5. Inthe data grid, click the check to reprint.

Tip: To select multiple sequential checks, press and hold the Shift key and click the first and last
sequential check. To select multiple non-sequential checks, press and hold the Ctrl key and click
each individual check.

6. Click Reprint Selected. The Check Re-Print Options dialog box appears.
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7. Do one of the following:

e To use the same check numbers that you used originally, click Print the same Check
Numbers originally used.

e For pre-numbered check paper, click Check stock is pre-numbered and the next
number is: and then, in the box, type the starting check number. The Invoices program
doesn't print the check numbers on the pre-numbered check paper. The Invoices
program does use the check number you type in the box to record the check numbers in
the check register.

8. Click OK. The Print dialog box appears.

9. Modify the settings as necessary and then click Print. The Invoices program prints the checks.
The Invoices program records date printed and the check numbers in the Selected Entries data
grid.

Print the ACH Transfer List

Use the ACH Transfers window to print the Automated Clearing House (ACH) transfer list for customers
that your organization configured for ACH transfers. The list includes the dollar amounts to pay based on
the invoices generated in Invoices. Use the list as a reference when transferring payments.

To print the ACH transfer list

1. Inthe Invoices window, from the View menu, click Check Register. The Check Register window
appears.
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2. Click Show ACH to do. The ACH Transfers window appears.
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3. Click Print. The Print dialog box appears.
4. Modify the settings as necessary and then click Print. The list is output to the specified printer.

Reports

Reports

Use the Reports menu in the Invoices window to preview and print invoice-related reports.

Generate a Summary of Invoices Report for a Specific Time Period
Use the Invoice Summary Report to view invoices by customer for a specified time period.
To generate a Summary of Invoices report for a specific time period

1. Inthe Invoices window, from the Reports menu, click Invoice Summary Report and then click
Preview. The Invoice Summary Report dialog box appears.
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2. Inthe Select Invoices Created section, do one of the following:

e To generate the report for a specific month, click For system month and then, in the list
boxes, click the month and year.

e To generate the report for a specific date, click For specific date and then, in the list box,
click the date.

o To generate the report for a specific time period, click From and then, in the list boxes,
click the beginning and ending dates.

3. Inthe Customer Selection section, do one of the following:
e Toinclude all customers in the report, click Show all customers.

e Toinclude in the report only those customers with invoices, click Show only customers
that have invoices.

4. In the Sort Option section, do one of the following:
e To sort the report by customer number, click Order by customer number.
e To sort the report by customer name, click Order by customer name.

5. Click Begin. The Report Viewer window appears.
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6. To export the report to a file, do the following:

a. In the menu bar, click the Export icon. The Export Report dialog box appears.
b. In the File name box, type a name for the report.
C. In the Save as type, click the type of file to export the report to and then click Save. When the

export completes, a notification dialog box appears.
d. Click OK.
7. To print the report, do the following:
In the menu bar, click the Print icon. The Print dialog box appears.
a. Modify the settings as necessary and then click Print.
| Note: You can also print the report from the Reports menu by clicking Invoice Summary |
Report, specifying the report parameters, and then clicking Printer.
Generate a Summary of Invoices Report for a Customer or Group of Customers

Use Summary of Invoices tab in the Invoices window to generate a Summary of Invoices report for a
customer or group of customers.

Note: The data grid includes invoices for parent customers only. If you select a child customer, the
Invoices program displays the parent customer number to reference.

To generate a Summary of Invoices report for a customer or group of customers

1. Inthe Invoices window, in the Navigation pane, click the customer or invoicing group for which
to display invoices.

2. Click the Summary of Invoices tab.
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To change the date range for which to display invoices, click the arrow next to the date range
boxes and click a beginning and ending date.

In the data grid, click one or more invoices.

Tip: To select multiple sequential invoices, press and hold the Shift key and click the first and
last sequential invoice. To select multiple non-sequential invoices, press and hold the Ctrl key
and click each individual invoice.

From the Actions menu, click Print. The Print dialog box appears.

6. Modify the settings as necessary and then click Print. The report is output to the specified

printer.

Generate a Summary of Receivables Report

Use the Summary of Receivables report to view a summary of collection fee amounts owed to your

agency.

To generate a Summary of Receivables report

1. Inthe Invoices window, from the Reports menu, click Receivables Report and then click
Preview. The Report Viewer window appears.
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2. To export the report to a file, do the following:
a. In the menu bar, click the Export icon. The Export Report dialog box appears.
b. In the File name box, type a name for the report.
C. In the Save as type, click the type of file to export the report to and then click Save. When the

export completes, a notification dialog box appears.
d. Click OK.
3. To print the report, do the following:
In the menu bar, click the Print icon. The Print dialog box appears.
a. Modify the settings as necessary and then click Print.

Note: You can also print the report from the Reports menu by clicking Receivables Report and
then clicking Printer.

Generate a Bank Account Ledger Report

Use the Bank Account Ledger report to view the ledger for each trust account that your organization
configured in Latitude.

To generate a Bank Account Ledger report

1. Inthe Invoices window, from the Reports menu, click Bank Transaction Report and then click
Preview. The Report Viewer window appears.
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2. To export the report to a file, do the following:

a.
b.

C.

d.

3.

Zoom Factor: Page Width

In the menu bar, click the Export icon. The Export Report dialog box appears.

In the File name box, type a name for the report.

In the Save as type, click the type of file to export the report to and then click Save. When the
export completes, a notification dialog box appears.

Click OK.

To print the report, do the following:

In the menu bar, click the Print icon. The Print dialog box appears.

Modify the settings as necessary and then click Print.

Note: You can also print the report from the Reports menu by clicking Bank Transaction Report
and then clicking Printer.

Generate an Uncleared Checks Report

Use the Uncleared Checks Report to view a list of checks received from the customer that have not
cleared the bank.

To generate an Uncleared Checks Report

1.

In the Invoices window, from the Reports menu, click Uncleared Checks Report and then click
Preview. The Report Viewer window appears.
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2. To export the report to a file, do the following:

a. In the menu bar, click the Export icon. The Export Report dialog box appears.
b. In the File name box, type a name for the report.
C. In the Save as type, click the type of file to export the report to and then click Save. When the

export completes, a notification dialog box appears.
d. Click OK.

3. To print the report, do the following:

In the menu bar, click the Print icon. The Print dialog box appears.

a. Modify the settings as necessary and then click Print.

| Note: You can also print the report from the Reports menu by clicking Uncleared Checks |

Report and then clicking Printer.

Generate a Customer Open Item Summary Report

Use Summary of Open Items tab in the Invoices window to generate a Customer Open Item Summary
report for a customer or group of customers.

Note: The data grid includes invoices for parent customers only. If you select a child customer, the
Invoices program displays the parent customer number to reference.

To generate a Customer Open Item Summary report

1. Inthe Invoices window, in the Navigation pane, click the customer or invoicing group for which
to display invoices.
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2. Click the Summary of Open Items tab.

3. To change the date range for which to display invoices, click the arrow next to the date range
boxes and click a beginning and ending date.

4. Inthe data grid, click one or more invoices.

Tip: To select multiple sequential invoices, press and hold the Shift key and click the first and
last sequential invoice. To select multiple non-sequential invoices, press and hold the Ctrl key
and click each individual invoice.

5. From the Actions menu, click Print. The Print dialog box appears.
6. Modify the settings as necessary and then click Print. The report is output to the specified
printer.
Report Viewer

Use the Report Viewer window to view and print a report, invoice, or customer statement. The Report
Viewer window appears when you:

e Generate areport.
e Generate or reprint an invoice.
e Preview a statement.

The following example is for a report.

T e )
W 3 1 LN

Summary of Invoices
All customers for system month 042013 |
Repert Dae: 4/11/2013 1
Invoice(5) Paid Us Paad Cust  Collectnons Fesg DueUs Due Cust Currency
0000001 CUSTOMERONE 10004 446088 0.00 4.460.88 1,11522 0.00 3.34566 UsD
0000006 CUSTOMERFOUR 10006 49.00 0.00 49.00 12.25 0.00 36.75 UsD
4,500.88 0.00 4,508 111747 0.00 338241
& n F
Current Page No.: 1 Total Page Ne.: 1 Zoom Facter: Page Width
Icon Description
e Exports the report to a file.
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Icon Description

| Prints the report.

4 Displays the first page of the report.

L | Displays the previous page of the report.

2 Displays the next page of the report.

b Displays the last page of the report.
1/1 Indicates the report page currently displayed and the total number of pages in the report.
i Opens the Find Text dialog box to allow you to search for text within the report.

o - Increases or decreases the text size when viewing the report on your monitor. Changing the

text size here does not affect the size of the text on the printed report.
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